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 . ددهاي معادل آن در زبان میانی تبدیل می شونکدهاي سی شارپ به ک

 . دکدهاي زبان میانی در یک فایل اسمبلی ذخیره می شون

تبدیل  ،کدهاي زبان میانی را در لحظه به کدهایی که براي کامپیوتر قابل خواندن باشند JITوقتی کدها اجرا می شوند کامپایلر 
  . دمی کن

است و نقشه اي است براي معادل سازي  CLRنیز دارد که بخشی از ) CTS(مشترك دات نت ویژگی دیگري به نام سیستم نوع 
چون هر دو از نوع  ،در ویژوال بیسیک یکسان هستند Integerدر سی شارپ و نوع  intنوع  CTSبا .  انواع داده ها در دات نت

System.Int32 پاك کردن خانه هاي بلا استفاده حافظه در یک فایل . دمشتق می شون)Garbage collection ( یکی دیگر از
هنگامی که از منابعی، زیاد استفاده نشود دات نت فریم ورك حافظه استفاده شده توسط  . تویژگیهاي دات نت فریم ورك اس

 . دبرنامه را آزاد می کن

 

  سی شارپ چیست؟

سی شارپ  ترکیبی از  . تشده اس گرا است که توسط شرکت مایکروسافت ساختهشیء  یک زبان برنامه نویسی) #C(سی شارپ 
زبان سی شارپ را راحت یاد  که اگر با این دو زبان آشنایی دارید این شانس را دارید . تاس Javaو  ++Cقابلیتهاي خوب 

این زبان به قدري راحت است که هم کسانی که قبلا برنامه نویسی نکرده اند و هم دانش آموزان می توانند راحت آن را  . دبگیری
از سی شارپ می توان براي ساخت برنامه هاي تحت ویندوز ،تحت وب ،وب سرویس ها ،برنامه هاي موبایل و بازي ها  . داد بگیرنی

می توان به جاي واژه ویژوال سی شارپ از کلمه سی شارپ استفاده کرد اما ویژوال سی شارپ به معناي استفاده  . داستفاده کر
زبان برنامه نویسی سی شارپ تنها زبانی است که مخصوصا  . دکی ویژوال استودیو می باشهمزمان از سی شارپ و محیط گرافی

سی شارپ از کتابخانه کلاس دات نت که شامل مجموعه بزرگی از اجزا از قبل  . تبراي دات نت فریم ورك طراحی شده اس
سی شارپ یک برنامه بسیار  . دکمک می کنناین اجزا به ساخت هر چه سریعتر برنامه ها  . داستفاده می کن ،ساخته شده است

ساختار این زبان نسبت  . دو با آن می توان برنامه هایی با قابلیت مدیریت بیشتر و درك آسان ایجاد کر گرا استشیء  قدرتمند و
  . تبه زبانهاي دیگر بسیار آسان و قابل فهم اس

سی شارپ یکی از زبانهایی است که از تکنولوژي  . دصب شوبراي اجراي یک برنامه سی شارپ ابتدا باید دات نت فریم ورك ن
همچنین یک محیط توسعه یکپارچه دارد که  . دکن پشتیبانی می XNAو  ASP.NET, Silverlight هاي دیگر دات نت مانند

طور دائم  این زبان به . دن نیز به نوبه خود داراي ابزارهاي مفیدي است که به شما در کدنویسی در سی شارپ کمک می کنآ
سی شارپ یکی از بهترین زبانهاي برنامه نویسی  . دتوسط مایکروسافت به روز شده و ویژگیهاي جدیدي به آن اضافه می شو

  . تدات نت اس
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 ویژوال استودیو

و  براي کمک به شما براي توسعه برنامه هاي سی شارپ   ابزارهایی توسعه یکپارچه اي است، که داراي  ویژوال استودیو محیط
یا هر برنامه ویرایشگر متن دیگر   notepad استفاده از برنامه  شما می توانید یک برنامه سی شارپ را با. دباش دات نت می

بنویسید و با استفاده از کامپایلر سی شارپ از آن استفاده کنید، اما این کار بسیار سخت است چون اگر برنامه شما داراي خطا 
توجه کنید که کلمه ویژوال استودیو هم به ویژوال استودیو و هم به ویژوال سی شارپ اشاره  . دشوخطایابی آن سخت می  ،باشد

توصیه می کنیم که از محیط ویژوال استودیو براي ساخت برنامه استفاده کنید چون این محیط داراي ویژگی هاي زیادي . ددار
عداد زیادي از پردازش ها که وقت شما را هدر می دهند به ت . دبراي کمک به شما جهت توسعه برنامه هاي سی شارپ می باش

است که شما را در  (Intellisense) یکی از این ویژگی ها اینتل لایسنس. دصورت خودکار توسط ویژوال استودیو انجام می شون
جازه می دهد در طول است که به شما ا  break point یکی دیگر از ویژگیهاي اضافه شده. دکدهایتان کمک می کن  تایپ سریع

ویژوال استودیو برنامه شما را خطایابی می کند و حتی خطاهاي کوچک . داجراي برنامه مقادیر موجود در متغیرها را چک کنی
را برطرف می کند ،همچنین داراي ابزارهاي طراحی براي ساخت یک رابط گرافیکی است ) مانند بزرگ یا کوچک نوشتن حروف(

با این برنامه هاي قدرتمند بازدهی شما . تدیو براي ساخت همچین رابط گرافیکی باید کدهاي زیادي نوشکه بدون ویژوال استو
در حال حاضر آخرین نسخه ویژوال  . دافزایش می یابد و در وقت شما با وجود این ویژگیهاي شگفت انگیز صرفه جویی می شو

 Visualو ) ارزان قیمت(Visual Studio Professional  این نسخه به دو نسخه . تاس Visual Studio 2015 استودیو
Studio Enterprise )خبر خوب براي توسعه دهندگان نرم  . دتقسیم می شود و داراي ویژگی هاي متفاوتی هستن) گرانقیمت

اي ویژوال یکی از نسخه ه . دافزار این است که مایکروسافت تصمیم دارد که ویژوال استودیو را به صورت متن باز ارائه ده
این برنامه  . دمی باشد که آزاد است و می توان آن را دانلود و از آن استفاده کر  Visual Studio Community ،استودیو

کامل نیست و  (Community) این نسخه . ددر اختیار شما قرار می ده  #Cویژگیهاي کافی را براي شروع برنامه نویسی 
 Visual Studio که جایگزین Visual Studio Community حال استفاده از به هر . تخلاصه شده نسخه اصلی اس

Express  شده و به نوعی همان نسخه Visual Studio Professional  تکافی اس کتاباست، براي انجام تمرینات این . 

Visual Studio Enterprise 2015 مودارهاي مختلف داراي محیطی کاملتر و ابزارهاي بیشتري جهت عیب یابی و رسم ن
ویژوال استودیو فقط به سی شارپ خلاصه نمی شود و داراي زبانهاي  . دوجود ندارن Visual Studio Community است که در

رابط کاربري سی شارپ و ویژوال استودیو بسیار شبیه هم است و ما  . دبرنامه نویسی دیگري از جمله ویژوال بیسیک نیز می باش
 . ممرینات را با استفاده از سی شارپ انجام می دهیدر این کتاب بیشتر ت
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 دانلود و نصب ویژوال استودیو

 . مرا آموزش دهی Visual Studio Community 2015 در این درس می خواهیم نحوه دانلود و نصب

  

 Visual Studio Community 2015 دانلود

Visual Studio Community 2015 ت و می توانید آن را از لینک زیر دانلود کنیدبه صورت آزاد در دسترس اس : 
vs.aspx-studio-visual-us/downloads/download-https://www.visualstudio.com/en 

 Visual ظاهر می شود که در داخل این صفحه می توان با کلیک بر روي با کلیک بر روي لینک بالا صفحه اي به صورت زیر
Studio Community 2015 آن را دانلود کرد :  

 

 



      www.w3-farsi.comیونس ابراهیمی                   :تالیف و ترجمه                               مبانی زبان سی شارپ

       
 

16 
 

را انتخاب کرده تا تمام فایل  ISO زبان مورد نظر و سپس فرمت Visual Studio Community 2015 بعد از کلیک بر روي
را بر روي  ISO با این کار اگر می توان همین فایل . ددانلود شون Visual Studio Community 2015 هاي لازم جهت نصب

گیگابایت حجم دارد و براي  5حدود  ISO این فایل . دسیستم هاي دیگر بدون نیاز به دانلود مجدد فایل هاي لازم، نصب کر
  . ددانلود آن یز به یک اینترنت پر سرعت داری

 

 
 . دبرنامه شروع می شو ، دانلودDownload  با کلیک بر روي دکمه

  

 Visual Studio Community 2015  نصب

، به داخل آن رفته و بر  ISO بعد از اجراي فایل . دیا بالاتر باشی 8بعد از دانلود فایل، شما باید قادر به باز کردن آن در ویندوز 
 : دو بار کلیک کنید  vs_community.exeروي فایل 

 
 Install را انتخاب و بر روي دکمه Typical گزینه . دفحه اي به صورت زیر ظاهر می شوبا کلیک بر روي فایل بالا ص

 : کلیک کنید
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 . دصبر کنید تا مرحله نصب به پایان برس
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 Visual کلیک نمایید تا Launch در این صفحه بر روي دکمه . دبعد از اتمام نصب، صفحه اي به صورت زیر نمایان می شو
Studio Community  داجرا شو . 
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 Visual Studio Community  شروع کار با

 : برنامه ویژوال استودیو را اجرا کرده و منتظر بمانید تا صفحه آن بارگذاري شود
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اگر داراي یک اکانت مایکروسافت باشید می توانید تغییراتی که در ویژوال استودیو می دهید را در فضاي ابري ذخیره کرده و اگر 
ر کامپیوتر دیگر نصب کنید، می توانید با وارد شده به اکانت خود، تغییرات را به صورت خودکار بر روي ویژوال آن را د

 : رد کنید Not now, maybe later البته می توانید این مرحله را با زدن دکمه . داستودیویی که تازه نصب شده اعمال کنی
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 من به صورت پیشفرض ظاهر . دشده در ویژوال استودیو یکی را انتخاب کنی شما می توانید از بین سه ظاهر از پیش تعریف
Blue را انتخاب می کنم ولی شما می توانید بسته به سلیقه خود، ظاهر دیگر را انتخاب کنید :  
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 : صفحه اي به صورت زیر ظاهر می شود Start Visual Studio بعد از زدن دکمه
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صفحه اصلی برنامه به صورت زیر نمایش داده می شود که نشان از نصب  Visual Studio Community بعد از بارگذاري کامل
 : کامل آن دارد
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 خوش آمدید استودیوبه ویژوال 

لازم است که با انواع  . مبه شما مطالبی آموزش دهی استودیودر این بخش می خواهیم در باره قسمت هاي مختلف محیط ویژوال 
بعد از اینکه صفحه بالا بسته شد وارد صفحه  . دبرنامه ویژوال سی شارپ را اجرا کنی . داین محیط آشنا شوی ابزارها و ویژگیهاي

 : آغازین ویژوال سی شارپ می شویم
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  . داین صفحه بر طبق عناوین خاصی طبقه بندي شده که در مورد آنها توضیح خواهیم دا

  

  )Menu Bar(منو بار 

با کلیک بر روي هر منو  . تاي برنامه ها اسراي مختلفی براي ساخت، توسعه، نگهداري، خطایابی و اجکه شامل منوه)  1(منو بار 
به این نکته توجه کنید که منوبار داراي آیتم هاي مختلفی است که فقط در شرایط  . ددیگر منوهاي وابسته به آن ظاهر می شون

در زیر  . ددر صورتی نشان داده خواهند شد که پروژه فعال باش Projectبه عنوان مثال آیتم هاي منوي  . دخاصی ظاهر می شون
  :برخی از ویژگیهاي منوها آمده است 

 توضیح منو

File شامل دستوراتی براي ساخت پروژه یا فایل، باز کردن و ذخیره پروژه ها و خروج از آنها می باشد 

Edit ی و پیدا کردن یک مورد خاص می باشدشامل دستوراتی جهت ویرایش از قبیل کپی کردن، جایگزین 

View  به شما اجازه می دهد تا پنجره هاي بیشتري باز کرده و یا به آیتم هايtoolbar دآیتمی اضافه کنی . 

Project دشامل دستوراتی در مورد پروژه اي است که شما بر روي آن کار می کنی . 
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Debug ي برنامه را می دهدبه شما اجازه کامپایل ، اشکال زدایی و اجرا 

Data دشامل دستوراتی براي اتصال به دیتابس ها می باش . 

Format دشامل دستوراتی جهت مرتب کردن اجزاي گرافیکی در محیط گرافیکی برنامه می باش . 

Tools  دبراي ویژوال سی شارپ و ویژوال استودیو می باش...شامل ابزارهاي مختلف، تنظیمات و . 

Window دما اجازه تنظیمات ظاهري پنجره ها را می دهبه ش . 

Help شامل اطلاعاتی در مورد برنامه ویژوال استودیو می باشد 

  
The Toolbars 

Toolbar )2 (دبه طور معمول شامل همان دستوراتی است که در داخل منو ها قرار دارن . Toolbar  همانند یک میانبر عمل می
اگر در مورد عملکرد هر کدام از این دکمه ها  . داي آیکونی است که کاربرد آنرا نشان می دهدار Toolbarهر دکمه در  . دکن

نشان داده ) tool tip(شک داشتید می توانید با نشانگر موس بر روي آن مکث کوتاهی بکنید تا کاربرد آن به صورت یک پیام 
همچنین می توانید با کلیک راست بر روي منطقه . دبرخی از دستورات مخفی هستند و تحت شرایط خاص ظاهر می شون. دشو

برخی از دکمه ها داراي فلش هاي  . ددستورات بیشتري به آن اضافه کنیView > Toolbarsو یا از مسیر  toolbarخالی از 
اجازه جا به شما  toolbarسمت چپ هر  . دکوچکی هستند که با کلیک بر روي آنها دیگر دستورات وابسته به آنها ظاهر می شون

   . دبه جایی آن را می ده

  

  )Start Page(صفحه آغازین 

همچنین اگر از قبل پروژه اي ایجاد کرده اید می توانید آن  . دبراي ایجاد یک پروژه و باز کردن آن از این قسمت استفاده می شو
شد در مورد بخشهاي بعدي در  بخشهاي مهم ویژوال سی شارپ توضیح داده . دمشاهده و اجرا کنی Recent Projectsرا در 

 . دآینده توضیحات بیشتري خواهیم دادرسهاي 
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  استودیوگردشی در ویژوال 
Visual Studio Community   از تعداد زیادي پنجره و منو تشکیل شده است که هر کدام براي انجام کار خاصی به کار می

یک   File > New Projectاز مسیر  . مبا این قسمتها آشنا شوی یواستوداجازه دهید با نفوذ بیشتر در محیط ویژوال  . درون
  . دپنجره فرم ایجاد کنی
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 . دپنجره اي به شکل زیر نمایش داده خواهد ش

  

و یک اسم براي پروژه انتخاب می   Windows Forms Applicationهمانطور که در شکل بالا نشان داده شده است گزینه 
 : کلیک می کنیم تا صفحه زیر نمایان شود  OKکنیم و بر روي دکمه 
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 : مشخصات فرم بالا عبارت است از

  

  (Design) صفحه طراحی  - 1

فرم هاي ویندوزي رابطهاي گرافیکی بین کاربر و  . تاین صفحه در حکم یک ناحیه براي طراحی فرم هاي ویندوزي شما اس
شما در این صفحه می توانید کنترلهایی مانند  . تاس  GUIط گرافیکی یاکامپیوتر هستند و محیط ویندوز نمونه بارزي از یک راب

گرا شیء  جزییات بیشتر در مورد فرمهاي ویندوزي و کنترلها و برنامه نویسی . دبه فرمتان اضافه کنی.…دکمه ها ، برچسب ها و 
 . درا مطالعه کنیاما توصیه می شود ابتدا مبانی برنامه نویسی  . تدر فصل فرم هاي ویندوزي آمده اس

  

 (Solution Explorer)  مرورگر پروژه - 2

 . دبرنامه اي که توسط شما ساخته شده است را نشان می ده Solutionیک  . دپروژه و فایلهاي مربوط به آن را نشان می ده
حه شما نمایش داده در صف Solution Explorer اگر . دممکن است این برنامه یک پروژه ساده یا یک پروژه چند بخشی باش



      www.w3-farsi.comیونس ابراهیمی                   :تالیف و ترجمه                               مبانی زبان سی شارپ

       
 

30 
 

  Ctrl+Alt+Lبا کلیدهاي میانبر   و یا  View > Other Windows > Solution Explorerنمی شود می توانید از مسیر 
نشان داده شده پروژه فعال می  (Bold) اگر چندین پروژه در حال اجرا هستند پروژه اي که با خط برجسته . دآنرا نمایان کنی

 Solution Explorerبر روي   اگر بخواهید پروژه اي را که فعال نیست اجرا کنید، . دنامه اجرا می شوباشد و هنگام اجراي بر
پروژه را نشان  دوبا    Solutionزیر یک شکل . را انتخاب نمایید  Set as StartUp Projectکلیک راست کنید و سپس گزینه 

  . تد اسهر پروژه شامل فایلها و فولدرهاي مربوط به خو . دمی ده

 

 

  (Properties) پنجره خواص  - 3 
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خواص و رویدادهاي مختلف هر آیتم انتخاب شده اعم از فرم ، فایل ، پروژه و کنترل را نشان می  ،(Properties) پنجره خواص
در  . دکنی آنرا ظاهر  F4یا کلید میانبر  View > Properties Windowمی توانید از مسیر  ،اگر این پنجره مخفی است . دده

به عنوان مثال  . دخاصیت ها ، ویژگیها و صفات اشیا را نشان می دهن . دمورد خواص در درسهاي آینده مفصل توضیح خواهیم دا
اگر یک فرم یا کنترل را در صفحه طراحی و یا یک پروژه یا  . تیک ماشین داراي خواصی مانند رنگ ، سرعت، اندازه و مدل اس

این پنجره همچنین داراي  . دانتخاب کنید پنجره خواص مربوط به آنها نمایش داده خواهد ش  SolutionExplorerفایل را در
اتفاقی است که در شرایط خاصی پیش می آید  (event) یک رویداد . درویدادهاي مربوط به فرم یا کنترل انتخاب شده می باش

 کمبو باکس . ماصلاح می کنی (text box) داخل جعبه متنکلیک و یا متنی را در  (button) مانند وقتی که بر روي دکمه
(combo box) شکل بالا که با حرفA  را )…دکمه، فرم و(مورد نظرتان شیء  نشان داده شده است به شما اجازه می دهد که

وچک یا به هم است که کنترلهاي روي فرم بسیار ک این کار زمانی مفید . دکه می خواهید خواص آنرا تغییر دهید انتخاب کنی
برخی از این دکمه ها در  .(B) در زیر کمبو باکس بالا دکمه هاي مفیدي قرار دارند . دنزدیک بوده و انتخاب آنها سخت باش

دومین دکمه خواص را بر  . ددکمه اول خاصیت اشیا را بر اساس دسته هاي مختلفی مرتب می کن. دشرایط خاصی فعال می شون
 . دکند که پیشنهاد می کنیم از این دکمه براي دسترسی سریع به خاصیت مورد نظرتان استفاده کنی اساس حروف الفبا مرتب می

این دکمه به شما اجازه  . مسومین دکمه هم وقتی ظاهر می شود که یک کنترل یا یک فرم را در محیط طراحی انتخاب کنی
) که به شکل یک رعد و برق نمایش داده شده(کمه چهارمین د . ددسترسی به خواص فرم ویا کنترل انتخاب شده را می ده

در پایین شکل بالا توضیحات کوتاهی در مورد خاصیت ها و رویداد ها نشان  . درویدادهاي فرم ویا کنترل انتخاب شده را می ده
و در در ستون سمت چپ نام رویداد یا خاصیت . تشامل خواص و رویدادها اس(C) بخش اصلی پنجره خواص . دداده می شو

قرار دارد که توضیحاتی درباره خواص و  (D) در پایین پنجره خواص جعبه توضیحات . تستون سمت راست مقدار آنها آمده اس
 . درویدادها در آن نمایش داده می شو

 

  استودیوتغییر ظاهر ویژوال 
انید به دلخواه آن را تغییر را دوست نداشته باشید، می تو استودیو اگر موقعیت پنجره ها و یا ظاهر برنامه ویژوال 

کلیک کرده و آنرا می کشید تا پنجره به شکل زیر به حالت شناور  (title bar) براي این کار بر روي نوار عنوان . ددهی
 : در آید
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در‌سی‌شارپ‌‌ها‌داده
 

bool :true یا false 

byte :ٜػلأر  تذٖٚ تیسی 8 داد

:short تیسی 16 فحیح ػذد 

int :تیسی 32 فحیح ػذد 

long :تیسی 64 فحیح ػذد 

float :تیسی 32 اػؾاری ػذد 

double :تیسی 64 اػؾاری ػذد 

Char :تیسی 16 واراوسز 

string :تیسی 16 واراوسزٞای 

 

در ایٙجا ٔٙظٛر ٔٗ اس عيح ). ؽٕا ٔی زٛا٘یذ یه دادٜ عيح تالازز را تا دادٜ عيح خاییٗ زز ٔمذاردٞی وٙیذ

 (ٔجٕٛػٝ اػذاد ٚ حافظٝ ٔسغیز ٔی تاؽذ
float y = 7.0f; //y is of type float 

int j;          //j is of type int 

y = j;          //convert int to float 

 

تٝ ایٗ ػُٕ افيلاحا . اِثسٝ أىاٖ ٔمذاردٞی یه دادٜ عيح خاییٗ زز تا دادٜ عيح تالازز ٘یش ٚجٛد دارد

Castingٌفسٝ ٔی ؽٛد  .
1) 

j = (int)y; //convert float to integer 

2) 

float x = 1.0E45; 

int k = (int) x; 

3) 

int k; 

bool gtnum; 

gtnum = (k > 6); //true if k is greater than 6 

 

.  تا خيا ٔٛاجٝ ؽٛدcastingدر ٘ظز داؽسٝ تاؽیذ وٝ ٕٔىٗ اعر ػُٕ 

 ++c یا c تا اػذاد ٕٞا٘ٙذ Booleanدر ٘ظز داؽسٝ تاؽیذ وٝ أىاٖ ٔمذاردٞی ٔسغیزٞای ٕٞچٙیٗ 

.  تٝ دیٍز ٔسغیزٞا أىا٘دذیز ٘یغرBoolean زثذیُ ٔسغیز اس ٘ٛع ٚ. ٚجٛد ٘ذارد
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تبدیل‌انواع‌اعداد‌و‌رشته‌ها‌به‌یکدیگز‌
اِثسٝ ٔسذ . تٝ ػذد زثذیُ ٕ٘اییذرا  ٔی زٛا٘یذ اػذاد را تٝ رؽسٝ ٚ رؽسٝ Convertتا اعسفادٜ اس ٔسذ 

Convertدٞذ وٝ خظ اس زایح داذ تؼذ اس ٔسذ   زثذیلاذ دیٍزی را ٘یش ا٘جاْ ٔیConvert  

. ٔی زٛا٘یذ ٕٞٝ آٟ٘ا را تثیٙیذ
string s = Convert.ToString(x); 

float y = Convert.ToSingle(s); 

float x = 12.341514325f; 

string s = x.ToString("###.###"); //gives 12.342 

 

: زؼییٗ ٘ٛع ٚ ٔمذار تزای ٔسغیز در سٔاٖ زؼزیف
float loan = 1.23f;     //float 

long pig = 45L;         //long 

int color = 0x12345;    //hexadecimal 

 

: در عی ؽارج عٝ ٔمذار ثاتر اس لثُ زؼزیف ؽذٜ ٚجٛد دارد وٝ ػثارزٙذ اس
true, false, null 

اس رؽسٝ واراوسزٞای اس خیؼ  (ػٕٛٔا واروسزٞای وٙسزِی)تزای لزار دادٖ واروسزٞای خاؿ غیز رؽسٝ ای 

: زؼزیف ؽذٜ اعسفادٜ ٔی ؽٛد
„\n‟ newline (line feed) 

„\r‟ carriage return 

„\t‟ tab character 

„\b‟ backspace 

„\f‟ form feed 

„\0‟ null character 

„\”‟ double quote 

„\‟‟ single quote 

„\\‟ backslash 

 

:‌نامگذاری‌متغیز
در ٘أٍذاری ٔسغیزٞای دلر وٙیذ وٝ حزٚف وٛچه تا حزٚف تشري ٔسفاٚذ ٞغسٙذ در ٘سیجٝ عٝ وّٕٝ سیز 

: عٝ ٔسغیز ٔخسّف را زؼزیف ٔی وٙٙذ
temperature 

Temperature 

TEMPERATURE 

: یىی اس لاتّیسٟای عی ؽارج در ٔمذاردٞی ٔسغیزٞا اعسفادٜ اس چٙذ ػٍّٕز ٔغاٚی اعر
i = j = k = 0; 

ؽٕا ٔی زٛا٘یذ زؼزیف ٔسغیز را در ٞز لغٕسی . در آخز ٞز ٔسغیزی لثُ اس اعسفادٜ حسٕا تایذ زؼزیف ؽذٜ تاؽذ

. اس وذ خٛدزٖٛ لزار تذیذ
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 اپزاتورها‌و‌عملگزها

اَٚ ٘اْ ٘ٛع ٔسغیز ٔٛرد ٘ظززٖٛ رٚ زایح وٙیذ ٚ : تزای زؼزیف یه ٔسغیز وافیغر تذیٙقٛرذ ػُٕ ٕ٘اییذ

. تؼذ ٘أی را تزای ٔسغیز ا٘سخاب ٕ٘ٛدٜ ٚ در آخز ٔی زٛا٘یذ اٖٚ رٚ ٔمذاردٞی اِٚیٝ ٘یز تىٙیذ

: اعسفادٜ اس چٙذ ػلأر ٔغاٚی در ٔمذاردٞی اِٚیٝ ٔسغیز

تٝ .  ٘یش لادر تٝ اعسفادٜ اس چٙذ ػلأر ٔغاٚی تزای ٔمذاردٞی تٝ ٔسغیزٞا ٞغسیذ#C ؽٕا در Cٕٞا٘ٙذ 

: ٔثاَ سیز دلر وٙیذ

i = j = k = 0; 

 : تٝ دعسٛری ٔا٘ٙذ دعسٛر سیز زثذیُ ٔی ؽٛدCPUخیّی عادٜ اعر، ایٗ دعسٛر در سٔاٖ وأدایُ تزای 

i = 0; j = 0; k = 0; 

‌
 : اپراتورهای محاسثاتی

 + جٕغ

 - زفزیك

 * مزب

 / زمغٓ

 % تالیٕا٘ذٜ زمغیٓ فحیح

 

:  اپراتورهای منطقی

 & رٚی تیسٟا AND ػُٕ ززویة

 | رٚی تیسٟا OR ػُٕ ززویة

 ^ ػُٕ ززویة یای ا٘حقاری رٚی تیسٟا

 ~ ٔسٕٓ یه ػذد تایٙزی

 n<< حزور تیسٟا تٝ عٕر راعر

 n>> حزور تیسٟا تٝ عٕر

ٕٞچٙیٗ ؽٕا .  اجاسٜ اعسفادٜ اس ػٍّٕزٞای واٞؼ ٚ افشایؼ را داریذC# ٚ جاٚا ؽٕا در C ،C++ٕٞا٘ٙذ 

:  ٔی زٛا٘یذ اس دعسٛراذ ا٘سغاب خلافٝ ؽذٜ ٘یش اعسفادٜ وٙیذ

// Increment and Decrement Operators i = 5; 

j = 10; 
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x = i++; //x = 5, then i = 6 

y = --j; //y = 9 and j = 9 

z = ++i; //z = 7 and i = 7 

// Combining Arithmetic and Assignment Statements 

x = x + 3; //can also be written as: 

x += 3; //add 3 to x; store result in x 

//also with the other basic operations: 

temp *= 1.80; //multiple temp by 1.80 

z -= 7; //subtract 7 from z 

y /= 1.3; //divide y by 1.3 

ؽٕا حسٕا تایذ ؽزه خٛد را داخُ خزا٘سش .  اعسفادٜ ٔی ؽٛدifدر عی ؽارج تزای زقٕیٓ ٌیزی اس دعسٛر 

در غیز ایٙقٛرذ . اعسفادٜ ؽٛد { }اٌز رٚاَ اجزایی ؽزه ؽٕا تیؼ اس یه دعسٛر تاؽذ تایذ اس . لزار دٞیذ

اٌز ٔی خٛاٞیذ در فٛرذ ػذْ تزلزاری .  دعسٛر ٔٛرد ٘ظز خٛد را لزار تذیذifٔی زٛا٘یذ خظ اس دعسٛر 

در ایٗ حاِر اٌز .  اعسفادٜ ٕ٘اییذelseؽزه ؽٕا دعسٛر یا دعسٛراذ خاؿ دیٍزی اجزا ؽٛد تایذ اس 

ؽزه تزلزار تاؽذ، ٔجٕٛػٝ ای اس دعسٛراذ ٚ اٌز ٞٓ ؽزه تزلزار ٘ثاؽذ ٔجٕٛػٝ دیٍزی اس دعسٛراذ 

 .ٔی زٛا٘ذ اجزا ؽٛد

if ( y > 0 ) 

   z = x / y; 

else 

   z = 0; 

Console.writeLine(“z = “ + z); 

 

: عملگرهای مقایسه ای

أا در ٘ٛع ٕ٘ایؼ . ٕٞا٘ٙذ زٕأی ستاٟ٘ای تز٘أٝ ٘ٛیغی عی ؽارج ٘یش دارای ػٍّٕزٞای ٔمایغٝ ای اعر

اٌز ؽٕا تٝ . در عی ؽارج اس دٚ ٔغاٚی تزای ٔمایغٝ یىغاٖ تٛدٖ اعسفادٜ ٔی ؽٛد. ػٍّٕز زفاٚذ ٚجٛد دارد

.  ٚ ٘میل اعسفادٜ وٙیذ"یا"، "ٚ" ٘یاس داؽسٝ تاؽیذ ٔی زٛا٘ذ اس عٝ ػٍٕز ifززویة ؽزىٟا در یه دعسٛر 

 . ٘یغسٙذifاِثسٝ ایٗ عٝ ػٍّٕز ٔخسـ دعسٛر 

 < تشرٌسز

 > وٛچىسز

 == ٔغاٚی

 =! ٔخاِف

 =< تشرٌسز ٔغاٚی

 => وٛچىسز ٔغاٚی

 :عملگرهای منطقی

 &&  ٔٙيمیANDػٍّٕز 
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 ||  منطقی  ORػٍّٕز 

 ~  ٔٙيمیNOTعملگر 

 

if ( (0 < x) && ( x <= 24) ) 

   Console.writeLine(“Time is up”); 

 ؽٕا ٔی زٛا٘یذ ٔمادیز ٔخسّف أىا٘دذیز رٚ تزای یه ٔسغیز آسٔایؼ وٙیذ ٚ switchتا اعسفادٜ اس دعسٛر 

ٔسغیز ؽٕا تزای ٔمایغٝ تایذ یه ٔسغیز ػذدی یا رؽسٝ ای تاؽذ . ٔٙاعة رٚ اجزا ٕ٘اییذ (ٞای)عدظ دعسٛر

 :وٝ داخُ خزا٘سش لزار ٌزفسٝ اعر

switch ( j ) 

{ 

 case 12: 

  System.out.println(“Noon”); 

  break; 

 case 13: 

  System.out.println(“1 PM”); 

  break; 

 default: 

  System.out.println(“some other time...”); 

} 

تزای زغر ٔسغیز تا چٙذ ٔمذار .  ٔؾخـ ٔیؾcaseٝ ا٘سٟای ٞز تخؼ breakتا اعسفادٜ اس دعسٛر 

.  اعسفادٜ وٙیذbreak رٚ ٘ٛؽسٝ ٚ در آخزیٗ دعسٛر، اس caseٔی زٛا٘یذ دعسٛراذ 

: توضيحات كذ در سی شارج

 رٚػ زه خيی ٚ رٚػ ٔحذٚدٜ ای . در عی ؽارج دٚ رٚػ تزای ٘ٛؽسٗ زٛمیحاذ ٚجٛد دارد

//C# single-line comment 

/* also can go on 

for any number of lines*/ 
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 حلقه‌ها‌در‌سی‌شارپ

ایٗ حّمٝ ٞا . در عی ؽارج چٟار ٘ٛع حّمٝ ٚجٛد دارد وٝ تز اعاط ٘یاس ٔی زٛاٖ اس یىی اس آٟ٘ا اعسفادٜ ٕ٘ٛد

 while, do-while, for, foreach: ػثارزٙذ اس

while: ایٗ حّمٝ تغیار عادٜ اعر ٚ زا سٔا٘ی وٝ ؽزه حّمٝ تزلزار تاؽذ، دعسٛراذ داخُ حّمٝ اجزا ٔی 

. ؽٛ٘ذ

i = 0; 

while ( i < 100) 

   { 

   x = x + i++; 

   } 

do-while:  ٝایٗ حّمٝ ٘یش ٔا٘ٙذ حّمwhile ٝٔی تاؽذ تا ایٗ زفاٚذ وٝ حّم while ٔی زٛا٘ذ 

  حذالُ یىثار اجزا ٔی ؽٛدdo-whileافلا اجزا ٘ؾٛد أا حّمٝ 

i = 0; 

do { 

   x += i++; 

} 

while (i < 100); 

for:لغٕر ٔمذاردٞی اِٚیٝ، ؽزه ٚ ػٍّٕز : ایٗ حّمٝ یه حّمٝ عاخر یافسٝ ٚ دارای عٝ لغٕر اعر

  اس یىذیٍز جذا ٔی ؽٛ٘ذ ";"ایٗ عٝ لغٕر زٛعو . زغییز ؽٕار٘ذٜ حّمٝ

for (i = 0; //initialize i to 0 

     i < 100 ; //continue as long as i < 100 

     i++) //increment i after every pass 

 ٔمایغٝ 100 تا ػذد iدر ٞز ٔزجّٝ اس اجزا ؽٕار٘ذٜ . ؽٛد  در حّمٝ تالا ؽٕار٘ذٜ حّمٝ اس ػذد ففز ؽزٚع ٔی

 امافٝ 1 ٔمذار i تاؽذ تذ٘ٝ حّمٝ اجزا ٔی ؽٛد عدظ تٝ 100 وٛچىسز اس iٔی ؽٛد ٚ خظ اس تزرعی اٌز 

 ...ٔی ؽٛد ٚ 

 :تعریف متغير در حلقه

در ایٗ حاِر . در فٛرذ ٘یاس تٝ زؼزیف ٔسغیز ٔی زٛا٘یذ ؽٕار٘ذٜ حّمٝ را در سٔاٖ زؼزیف حّمٝ زؼزیف وٙیذ

 :تٝ ٔثاَ سیز زٛجٝ وٙیذ. ؽٕار٘ذٜ حّمٝ زؼزیف ؽذٜ فمو در ٕٞاٖ حّمٝ لاتُ دعسزعی اعر

for (int i =0; i< 5; i++) { 

   x[i] = i; 

} 

System.Console.WriteLine("i=" + i.ToString()); 
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اعسفادٜ اس ؽٕار٘ذٜ حّمٝ، خارج اس تذ٘ٝ حّمٝ ای وٝ ٔسغیز در آٖ زؼزیف ؽذٜ تاؽذ تاػث زِٛیذ خيا خٛاٞذ 

 .خظ اجزای خو آخز ٔثاَ فٛق تاػث زِٛیذ خيا خٛاٞذ ؽذ. ؽذ

 : در تعریف حلقه","استفاده از كاما 

ػلاٜٚ تز ایٗ ؽٕا . تا اعسفادٜ اس وأا ٔی زٛا٘یذ تیؼ اس یه ؽٕار٘ذٜ حّمٝ در زؼزیف حّمٝ داؽسٝ تاؽیذ

 :ٔی زٛا٘یذ در تخؼ ػٍّٕز ٘یش تیؼ اس یه ػٍّٕز را اعسفادٜ ٕ٘اییذ

for (x=0, y= 0, i =0; i < 100; i++, y +=2) 

{ 

   x = i + y; 

} 

 : وذ فٛق را ٔی زٛاٖ تٝ ؽىُ سیز ٘یش ٘ٛؽر

x = 0; 

y = 0; 

for ( i = 0; i < 100; i++) 

{ 

   x = i + y; 

   y += 2; 

} 

foreach:ایٗ ٔجٕٛػٝ ٔی زٛ٘ٝ ؽٕا ٞز . در ایٗ حّمٝ ؽٕا ٔی زٛا٘یذ ػٙافز یه ٔجٕٛػٝ را دٚر تش٘یذ

 : تزای درن تیؾسز تٝ ٔثاَ سیز زٛجٝ وٙیذ. ٘ٛع ػٙقزی تاؽذ

float[] z = {1.0f, 2.9f, 5.6f}; 

ArrayList arl = new ArrayList (); 

for (int j = 0; j < z.Length ; j++) { 

   arl.Add (z[j]); 

} 

// Sulotion no 1 to access all member of "arl" with for loop 

for (j = 0; j < arl.Count ; j++) { 

  Console.WriteLine (arl[j]); 

} 

// Sulotion no 2 to access all member of "arl" with foreach 

loop 

foreach (float a in arl) { 

  Console.WriteLine (a); 

} 

 

 جاٚا Java ٚیضٚاَ تیغیه ٚ VB عی خلاط خلاط، C++ ستا٘ی اعر وٝ تز اعاط ستاٟ٘ای C#عی ؽارج 

تز٘ذ ٚ  ای یىغاٖ تٟزٜ ٔی  اس زٛاتغ وساتخاC ٚ VB.NETٝ٘#ٞز دٚی ستاٟ٘ای . خیادٜ عاسی ؽذٜ اعر
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